Description

2D Consolidation
under a Strip
Footing

For LUSAS version: 16.0

For software product(s): | Any Plus version.

With product option(s): Nonlinear, Dynamic.

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

s o
pressure dissipation
and settlement in a

soil following the

L AR

application of a T

distributed load is to 0™

be investigated. L

Horizontal } 100m }
?I_?tplzcement tat ) ths Q Young’s modulus of the soil ~ E= 34.7 x 10° kN/m?
€Tt eage Is restraine =

to model the % Poisson’s ratio v=0.35
symmetrical g Density p=19tm’
boun_dary condition. Bulk modulus of water Kuw= 2.2 X 10°KN/m?

V,ertlcal Void ratio e=1.174
displacement at the o ,
base of the soil is Unit weight of water 7 w= 9.812 KN/m

restrained as the soil Soil permeability ke=k,=kz=1.0 x 10" m/s
rests on solid rock.
The pore pressure at ground level is prescribed to zero.




A

Modelling

2D Consolidation under a Strip Footing

Units of kN, m, t, s, C are used throughout.
Objectives
The required output from the analysis consists of:

O Settlement at the centre of the footing with time.

U Pore pressure distribution immediately after application of the load (undrained
response)

O Pore water pressure dissipation with time at the centre of the footing

Keywords

2D, Plane Strain, Consolidation, Pore Water Pressure, Time Stepping, Nonlinear,
Transient, Settlement, Two Phase Materials, Default Assignments, Graphs

Associated Files

U pwp_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter a File name of pwp

e Use the default User-defined working folder.

e Ensure an Analysis type of Structural is set.

e Select an Analysis Category of 2D plane strain
e Set Model units of kN,m,t,s,C

e Leave the Timescale units as Seconds

e Select a Startup template of 2D Plane Stress.




| Attributes

|Mesh
| Surface...

Modelling

e Ensure the Layout grid is set as None
e Enter a Title of Consolidation under a Strip Footing

e Click the OK button.

Note. The Undo button may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Mesh Definition

Since this analysis requires the modelling of pore water pressure, plane-strain two phase
elements will be used.

e Select Plane strain two phase, Quadrilateral, Quadratic elements. Ensure the
Regular mesh option is selected with Automatic divisions so that Modeller uses
the mesh divisions assigned to each line.

e Give the attribute the name Plane Strain Two Phase and click the OK button to
add the mesh attribute to the e?b Treeview.

e Inthe &b Treeview click on the mesh attribute Plane Strain Two Phase with the
right-hand mouse button and select the Set Default option. This will ensure all
newly created surfaces will be assigned the elements defined in this mesh attribute.

Material Properties

For consolidation analysis both the elastic and two-phase soil properties need to be
defined. The overall ‘equivalent’ bulk modulus of the soil is related to the bulk modulus
of the pore fluid and the bulk modulus of the solid soil particles by the formula:

1 n (-n) n

+ ~
Ke Kf Ks Kf

Where
Ke is the equivalent bulk modulus of the soil
Kf is the bulk modulus of the pore fluid
Ks is the bulk modulus of the solid soil particles
n is the porosity of the soil

The porosity of the soil is related to the void ratio by the formula:
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€
Porosity n = 1— =0.54

+e
| Attributes e Enter the isotropic material properties for the soil as Young’s Modulus 34.7E3,
| Material _ > Poisson’s Ratio 0.35 and Mass density 1.9
| Isotropic...
o Click on the Two phase check box at the top right-hand corner of the dialog.
Isotropic
Using the following properties
[™ Plastic I~ creep [ Damage [ shrinkage I viscous ¥ Two phase
Elastic Two Phase |
% Fully saturated Value

I ) Bulk modulus of zolid phase 27e6
PRI R Bulk modulus of fluid phase 55k

" Piecewise linzar partially sakurated Porosity of medium 0.54
Unit weight of fluid 5812
Defifie cUrves, . | Hydralic conductivity in global X direction 0.01e-6
Hydralic conductivity in global Y direction 0.01e-6
[™ Incompressible solids Hydralic conductivity in global Z direction 0.00e-6

Density of flud i

Mame | Fissured Clay| j ﬂ (new)
oK | Cancel | Apply | Help |

e For a Fully saturated condition enter the properties as shown in the dialog above.

Note. For the purposes of this example and to comply with a corresponding test case
/ the undrained bulk modulus of the soil is set to be the same as that of the pore fluid.

e Enter the attribute name as Fissured Clay and click the OK button to add the
attribute to the &b Treeview.




| Geometry
[Surface >
By Coords...
| Geometry
[Surface >
By Coords...
| Attributes
[Mesh >
Line...

Modelling

In the & Treeview click on the attribute Fissured Clay with the right-hand mouse
button and select the Set Default option. This will ensure all newly created features
will be assigned the properties defined in this material attribute.

Feature Geometry

J Enter coordinates of (0, 0), (5, 0), (5, 10) and (0, 10) to define the soil under the
load. Use the Tab key to move to the next entry field on the dialog. When all
coordinates have been entered click the OK button.

_I Enter the coordinates of (5, 0), (100, 0), (100, 10), (5, 10) to define the remainder
of the soil.

Mesh Grading

Define a Line mesh with element type None and 16 divisions.
Select the Spacing button.

Choose the Uniform transition option and set the Ratio of first to last element to
0.1

Click OK to accept the spacing properties.

Give the attribute name as Null 16 Graded and click the Apply button to add the
attribute to the % Treeview and keep the dialog active.

Define a Line mesh with 12 divisions.

Select the Spacing button.

Enter the Uniform transition option and set the Ratio of first to last element to 5
Click OK to accept the spacing properties.

Give the attribute name as Null 12 Graded and click OK to add the attribute to the
& Treeview.




| Attributes

Support...

2D Consolidation under a Strip Footing

Select these 2 horizontal Lines
and assign "Null 16 Graded"

N

- )
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Select these 3 vertical Linesand assign "Null 12 Graded"

Select the horizontal lines of the larger surface as shown and assign the mesh
attribute Null 16 Graded

Select all the vertical lines as shown (Use the Shift key to add to the initial
selection) and assign the mesh attribute Null 12 Graded

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line, and using the Geometry>Line>Reverse menu.
The end result should be a mesh that looks like this:

Supports

Define a support to prescribe zero pore pressure.

Click on the option to make the Pore pressure Fixed

Enter the attribute name as Fixed PWP and click the OK button.

Assign the supports to the model.

Select the vertical Line on the left-hand side of the model and drag and drop the
support attribute Fixed in X from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases

Select the 2 horizontal Lines representing the base of the soil and drag and drop the
support attribute Fixed in Y from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases




| Attributes

Loading...

Modelling

e Select the Line at ground level on the right-hand side of the model (see image) and

drag and drop the support attribute Fixed PWP from the & Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support
attribute to All analysis loadcases

Select thisline

Loading

e Select the Face option and click Next
o Enter loading of 3450 in the y Direction
o Enter the attribute name of Distributed Load and click the Finish button.

e Select the top line on the left-hand side of the model and drag and drop the
Distributed Load attribute onto the selection. With the Assign to lines option
selected click OK to assign the loadcase attribute to Loadcase 1.

Select thisline

Analysis Control

With this consolidation problem an automatic time stepping procedure is adopted. This
is because consolidation is a typical diffusion process in which the field changes rapidly
at the start of the process before settling down to a steady state condition a considerable
time after the initial load is applied. The automatic time stepping procedure enables the
time step to be modified so that the small time steps required at the start of the problem
can be increased as the analysis progresses. In some cases the overall response time can
be orders of magnitude larger than the initial time step.

The initial time step is important since the early variations in pore pressure must be
accurately accounted for. Vermeer and Verruijt suggest the following criteria for
determining the initial time step where Ah is the minimum distance between nodes.
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9.812
6 x34.7E3 x1E-8

At > Lo (Ahy = x 014> ~100 secs
6EK

Note. The distance between two nodes can be determined by selecting the two nodes
/ and then picking the Utilities>Mesh>Distance between Nodes entry.

o In the "= Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Nonlinear & Transient from the Controls menu.

Nonlinear & Transient

— Incrementation — Solution stategy
v Maonlingar [~ Same as previous lnadcase
Incrementation I tanual - l M number of iterations I'I 2
Starting load factor ID.1 Rezidual force nom ID.1
tax change in load factar ID.D Incremental dizplacement naorm I'I 0
Max tatal laad Factar I‘I.D Advanced... |
v | fidljust mad based »
he dnsiled Based o corvE e — Incremental LUSAS file output
Iterations per increment I4 = Same as previous lnadeags
Advanced! | Output file |1
Flat fils I'I
¥ Time domain
I Conszolidation - I Restart file ID
Initial time step 100 I ax number of saved restarts ID
Total response time: 1E7 Log file I'I
¥ &utomatic time stepping History file I'I
Advanced... |

— Commah to all

Idax time steps or increments IED
oK I Cancel Help

In the Incrementation section:

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.
e Enter an Initial time step of 100

e Select the Automatic time stepping option.

e Select the Advanced button in the Time domain section of the dialog.




Running the Analysis

e On the Advanced time K (] (il Advanced Time Step Parameters
parameters dialog set the Time step :
. S Time step scale safety factor 0.9
increment restriction factor to 2
Time step increment restriction factor I 2
e Set the Minimum time step to 100 Minimum time step 100
i i Maximum time step I 1E7
e Set the Maximum time step to 1E7 Y —— o
e Set the Minimum time step for | Temnatenvake o0
termination to0 Exponent far increasing bime step (GEE-FIFIT IE.III
e Click OK to return to the Nonlinear Integration factor alpha
and Transient control dialog. MErEET EEETiEE Lo
Integration factor gamma I 0.5
e On the _ Nonlinear an_d Transient I Alow step reductions
control dialog set Max time steps or e — E—
increments to 50
Cancel | Help |

e Click OK to set the loadcase control.

Saving the model

|Fi|k;ave— El Save the model file.

Running the Analysis

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

- U pwp.out this output file contains details of model data, assigned attributes
H and selected statistics of the analysis.

U pwp.mys this is the LUSAS results file which is loaded automatically into
the Treeview to allow results processing to take place.




| File
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[New...

| File

| Script

| Run Script...

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O pwp_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as pwp

e To recreate the model, select the file pwp_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.

Viewing the Results

Loadcase results can be seen in the .= Treeview. For a nonlinear analysis the last solver
results time step is set active by default.

o If present, turn off the Geometry, Mesh and Attributes layers in the 5= Treeview.

Settlement

e In the (5 Treeview, right-click on the first load increment Time Step 0 and select
the Set Active option to view results immediately after the loading is applied.

e Click the Deformations button in the Treeview and select the Specify factor
option. Specify a factor of 1 and click OK to visualise the deformed mesh for the
first time step.
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| Utilities

Graph Wizard...

Viewing the Results

prAa

A graph of the deformation over time will be created using the graph wizard.
e Zoom into the left-hand side of the Select this node

model and select the node on the

centre line at the centre of the

footing e

e With the Time history option ]
selected click Next

Firstly define the data to be used for
the X axis.

e Selected the Named option and
click Next

¥

e Select Response Time from the
drop down list and click Next

Secondly define the data for the Y axis.
e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specified single node drop down list.
Click Next

For the X Scale enter Manual values of minimum 100 and maximum 10e6
respectively.

e Select the Use logarithmic scale option.
o Title the graph as Settlement under centre of footing

e Click Finish to display the graph of settlement over time under the centre of the
strip footing.
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Consalidation under a strip footing

oettlement under centre of footing

-0.45
0.5

085 [
0B i
-0.65

PR . S T R P,

Disp ¥ Made 18(16)

Response Time(15)
#-Disp ¥ Mode 18(16) / Response Time(13)

E Close the graph window
Maximise the graphics window.

Pore water pressure

The distribution of pore pressure is to be shown using contours.

Select the Contour Range tab and set the Interval to 250

With Time Step O set active in the @ Treeview, and with no features selected, click
the right-hand mouse button in a blank part of the view window and select

Contours to add the contours layer to the = Treeview.

Select Displacement from the Entity drop down list and PRES from the component
drop down list.

Click the OK button to display contours of the undrained pore pressure distribution
(Time step 0) immediately after the loading is applied.

12



| utilities

Graph Wizard...

Viewing the Results

Note. The dissipation of pore water pressure over time may be observed by creating
an animation of the contour display.

e To observe the distribution of pore water pressure at a particular time after the

application of loading activate the appropriate time step from the () Treeview by
selecting the time step with the right-hand mouse button and choosing the Set
Active option.

The dissipation of pore water pressure under the footing is to be presented on a graph.
e Select the node on the centreline under the footing as before.

e With the Time history option selected click Next

Firstly define the data to be used for the X axis:

e Selected the Named option and click Next

e Select Response Time from the drop down list and click Next

Secondly define the data for the Y axis:

e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and PRES from the Component
drop down list.

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next
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| utilities

Graph Wizard...

2D Consolidation under a Strip Footing

e For the X Scale
ensure that
Manual values of

Consalidation under a strip footing

Dissipation of pare water pressure

e For the Y Scale
leave the values as a0n
the defaults.

minimum 100 and 2500
maximum  10e6 '
respectively  are 4
used. 2000 i
§ '

e Select the Use = 1500 i
Logarithmic = :

le opti E :

scale option = 1000 3

e Title the graph as o
Dissipation  of =] = =] = ] S
— (] - - — -—
pore water - = =
pressure -
Fesponse TimeH)

e Click Finish to _
display the -Node 18(10) / Response Time(H)

dissipation of pore water pressure over time under the centre of the strip footing.

E Close the graph window.
Maximise the graphics window.

As the pore water dissipates the load is carried by the soil. The increase in effective
stress in soil can be observed on a graph of effective stress against response time.

e Ensure the node on the centreline under the footing still selected.
e With the Time history option selected click Next

Firstly define the data to be used for the X axis

e Select the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis

e With the Nodal option selected and click Next

e Select Stress - Plane Strain from the Entity drop down list and SY from the
Component drop down list.

14



Viewing the Results

e The extent to be Consolidation under a strip footing
graphed will be

set to Specified
single node and
the node selected
will be seen in the
Specify node
field. Click Next

Effective soil stress

-1000

-1500

e For the X Scale -2000

ensure that
Manual values of
minimum 100 and
maximum  10e6
respectively  are

used. 23500
=
e Select the Use =

Logarithmic
scale option.

FREYEIT
|
i
i
i

[NERLN
FRYEIT

L1 N

atress 3% Mode 18(14)

1000
10000
100000

Response Time(13)
e For the Y Scale  -#Stress S Mode 18(14) / Response Time(13)
leave the values as
the defaults.
o Title the graph as Effective soil stress

e Click Finish to display the graph of the effective soil stress over time under the
centre of the strip footing.

This completes the example.
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